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Note: The following assumes that you have already set up your Palm device. If not, 

you should consult the manual that came with the unit. You will at least need to 
have sufficient battery power, and have completed the initialization procedures 
(setting the date, time, etc.). 

 
It is recommended that you back-up your Amiga hard drive(s) with appropriate 
back-up software before installing Spitfire². 
 
 

Connecting Your Palm to Your Amiga 
 
In order for Spitfire² to communicate with your Palm device, your Palm needs to 
be connected to an available serial port on your Amiga. This involves connecting 
the Palm cradle to the serial port. 
 
To connect the cradle: 
 
1) With your Amiga turned off, plug the Palm cradle into an available serial port. 

If your Amiga only has a 25-pin serial port then a 9-pin to 25-pin adapter will 
be required to plug the Palm's cradle into the Amiga's standard serial port. 
This may or may not have come with your Palm. 

 
2) Reboot your Amiga. 
 
Tip! If you are using an additional serial port, such as a HyperCOM, Silversurfer, 

etc. remember to change the device name. Otherwise, Spitfire² will look for the 
"serial.device" serial port. 

 
Help!  What if you only have one serial port? It is possible to use Spitfire² with an 

Amiga equipped with one serial port. However, you will not be able to use the 
port for more than one task at a time. Therefore, you could use the same port 
for Spitfire² and for connecting to the Internet via a modem, but you will have to 
swap cables and only perform one of the tasks at a time. 

 
 

Installing the Spitfire² software 
 
Once your Amiga has re-started, it is necessary to install the Spitfire² software. 
Simply double-click on the "Install Spitfire" icon in the "Installation" drawer. 

Chapter 1 
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This will use the standard Amiga installer program and will install Spitfire² and its 
appropriate files on to your hard drive. Simply follow the prompts until it is 
finished. 
 
Help!  Having problems with the installer? Reboot your Amiga and repeat the process 

again. Make sure that you have all the requirements necessary for Spitfire² to 
run (see requirements). If you are still unable to get Spitfire² installed, please 
contact the author. 

 
 

Starting Spitfire² for the first time 
 
You should find a Spitfire² directory where you had the installer place the 
Spitfire² program. Upon opening this directory, you will find two program icons - 
SpitfireHSM and SpitfireDAM. These are explained in greater detail below. 
 
To initialize Spitfire², double-click on the "SpitfireHSM" icon. With the 
unregistered version, a time delay will halt the program for a while. Once this has 
finished, Spitfire² will ask the user: 
 
1) To set up the serial port settings that the cradle is connected to. 
 

2) To perform a HotSync of the Palm (therefore be sure to have your Palm ready 
and its cradle connected to your Amiga). 

  
 

Setting up the serial port settings 
 
Spitfire² will pop up a window explaining the process involved. Click the "Okay" 
button, and the Spitfire² preferences window will appear. The first task is to 
ensure that you have the correct serial port settings. The following information is 
necessary: 
 

• Device:  This is the device name of your serial port. For the standard 
Amiga serial port, this should be left as "serial.device". However, if you 
are using a different serial port, this should be changed to the appropriate 
device name for that port. See the documentation that came with your 
additional serial port hardware for more information about the device 
name. 

 
• Port:  This is the port number for the device. Leave this to 1 for the Amiga 

serial port. This may vary for other serial ports. Once again, see the 
relevant documentation for more information. 
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• Max Baud:  This is the maximum baud rate at which Spitfire² can 
communicate with your Palm device. This can be set from 1200 to 115200 
baud, with the higher the baud rate the faster the transfer speed. The 
maximum baud rate will depend on the serial port being used, along with 
the cable length. 57600 baud should work on all serial ports. 

 
Spitfire² also has a directory where all Spitfire² data is kept. This is set to the 
"Spitfire:" assign, but it is possible to change this if you like. 
 
When you have set the information correctly, click on the "Save" button to save 
the changes. 
 
 

Performing a HotSync for the first time 
 
The Spitfire² HotSync Manager will then pop-up. As can be seen from the 
"Listening for HotSync...." it is waiting for you to HotSync your Palm device. To 
HotSync, do the following: 
 
1) Make sure that your Palm device is properly placed in its cradle, and that the 

cradle is connected to your Amiga (as above). 
 
2) Press the HotSync button on the Palm cradle. 
 
3) Spitfire² will connect to your Palm device, and a window will pop-up titled 

"HotSyncing...". Spitfire² will then synchronize the data on your Palm device 
with Spitfire², and back up the data on to your Amiga. 

 
4) When it has finished, it will return to the Spitfire² HotSync Manager's main 

menu. 
 
This first time procedure will allow Spitfire² to establish the proper accounts on 
your Palm and Amiga. 
  
If you have already performed a HotSync between your Palm and another 
computer, Spitfire² will recognize this and create a new account on your Amiga. It 
will not overwrite a user name established on a Palm unless specifically told to do 
so. 
 
Help!   If the above procedure does not work, check the connections between the 

Palm and your Amiga and make sure that your serial port connections are 
correct. The settings can be changed by clicking on the "Prefs" button in the 
Spitfire² HotSync Manager window. 
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The Spitfire HotSync Manager (SpitfireHSM) performs the HotSync operation 
necessary to allow Spitfire² to communicate with your Palm device. By running 
SpitfireHSM, you can automatically synchronize - that is, exchange and update - 
data between your Palm device and the Spitfire² software simply by pressing the 
HotSync button on your Palm cradle. 

 

Performing a HotSync 
 

Once you have installed Spitfire² and run SpitfireHSM in accordance with the 
instructions in the Installation chapter, you can perform a HotSync at any time in 
much the same way. This simply involves: 

 
1) Making sure that your Palm is properly connected to its cradle, which in turn 

is connected to the serial port of your Amiga. (as per the installation 
instructions); 

 
2) Starting SpitfireHSM, and then pressing the HotSync button on your Palm 

cradle. 
 

It is recommended that you perform a HotSync regularly. This will ensure that the 
data on your Palm and in Spitfire² is current, and will prevent any loss of data 
should your Palm run out of battery power or otherwise lose its data. Obviously, 
depending on how recently you have performed a HotSync with Spitfire², the data 
that Spitfire² has backed up will vary to that on your Palm. 

 
 

Configuring SpitfireHSM 
 

The Spitfire² HotSync Manager window contains three main buttons - "Prefs", 
"Conduits" and "View Log". Each will be explained in turn. 
 

Prefs 
 
This enables you to change the Spitfire² preferences. By clicking on the "Prefs" 
button, it brings up the preferences window. This allows you to change the serial 
port settings, as well as Spitfire²'s data directory. See the Installation chapter for 
information on how to alter these settings. 

 

Chapter 2 
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Conduits 
 

A conduit determines how records on your Palm and kept on Spitfire² are handled 
during a HotSync.  Each application has its own conduit, or uses the normal 
system conduit for HotSyncing. 
  
Spitfire² defaults to synchronizing of all files between your Palm device and the 
Amiga.  Generally, you should leave the settings to synchronize all files. In 
addition to the standard Address Book, Date Book, Memo Pad, and To Do List 
conduits, Spitfire² has System and Install conduits. 

 
To look at the conduit settings, click on the "Conduits" button in the SpitfireHSM 
window. This will bring up a "Conduits" window, which will list all of the 
conduits available. At the top of the window, your username should be visible. 
(See Advanced Spitfire² Operations for details on how to use multiple Palm 
devices). If it is not visible, click on the icon to the right of the username box, and 
a list of available usernames should appear. Click on your username to select it.  
 
Below your username are two columns, the one on the left listing the particular 
conduit, with the particular action for each of those conduits listed in the right-
hand column. 

 
Changing the conduits 

 
To change a conduit, simply double-click on its name, or select it and then click 
on the "Change" button. For the four main Spitfire² applications, you will be 
given the following options: 

 
• Synchronize the files:  This exchanges and updates data between your 

Palm and Spitfire². Any new changes made on your Palm will be updated 
on Spitfire² and vice versa. This is usually the appropriate setting to use. 

 
• Amiga overwrites Handheld:  Any changes made to the data in Spitfire² 

will overwrite the data stored on you Palm. 
 

• Handheld overwrites Palm:  Any changes made on your Palm will 
overwrite the data stored in Spitfire². 

 
• Do Nothing:  HotSyncing will do nothing for this application. Any 

changes made to the data in Spitfire² will not be updated on your Palm and 
vice versa. 

 
It is recommended that all applications be set to "Synchronize the files". This will 
enable you to make changes to the data in Spitfire² or on your Palm, and by 
HotSyncing both Spitfire² and your Palm will have the same updated data. 
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If you make any changes and wish to revert to the original settings that came with 
Spitfire², simply click on the "Default" button. To save any changes you made, 
click on the "Save" button. 
 
The Install conduit has two options: 
 

• Install files to Handheld:  This tells Spitfire² to install any files that have 
been selected in the "Install" application during the next HotSync 
operation (see the SpitfireDAM chapter). 

 
• Do Nothing:  No files will be installed during a HotSync operation. 

 
The System conduit backs up the system information (program files, settings, etc.) 
stored in your Palm device. There are a number of options available: 
 

• Restore from backup:  This will copy all the stored files from the Amiga 
to the Palm, thus restoring the Palm to the last backed up state. 

 
• Partial backup:  This will only backup applications that have a "backup" 

flag set for them.  This flag is set by the Palm application itself and cannot 
usually be controlled by a user.  The standard PalmDesktop by Palm 
Computing syncs in this mode. 

 
• Mirror backup:  This is the default setting. This will backup PalmOS files 

on both your Palm and on your Amiga, attempting to keep a mirror copy 
of files that are on the Palm on the Amiga. 

 
• Complete backup:  This will copy all files from your Palm on to your 

Amiga.  No files are ever deleted on the Amiga side. 
 

• Do Nothing:  No files will be transferred to or from your Palm and your 
Amiga. 

 
Once you have made any changes to the conduits, choose the "Save", "Use" or 
"Cancel" buttons to return to the main conduit window. At the bottom the main 
conduit window there are also "Info", "Default" and "Okay" buttons. By selecting 
a particular conduit and clicking on "Info", a window will appear with general 
information about that conduit.  
 
The "Default" button will restore all conduit settings to their original settings 
when Spitfire² was installed. 
 
Click on the "Okay" button when you have finished with the conduit settings. 
 

View Log  
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Clicking on this button in the SpitfireHSM window will open a window listing 
details of the last HotSync operation. It will list details on how each application's 
data was backup up (if it was), whether PalmOS files had been backup up, and 
any errors encountered. At the top of the window will be your username, which 
can be changed by clicking on the icon to the right of the username. (See 
Advanced Spitfire² Operations for details on how to use multiple Palm devices). 

 
Configuring the MUI Settings 

 
As Spitfire² is a MUI application, it is possible to configure the SpitfireHSM 
according to your tastes. Simply select "MUI..." from the "Settings" menu, by 
holding down your right mouse-button. This will bring up the standard MUI 
Settings window. From here you can alter the appearance of the windows, 
buttons, etc. in SpitfireHSM. It is also possible to snapshot the SpitfireHSM 
window so that it will appear the way you like it each time it starts. Remember to 
click on the "Save" button in the MUI settings to save any changes you make. 
 
Note: A registered version of MUI is necessary in order to save any changes you 

make to the MUI settings. 

 
Tip! It is also possible to iconify the SpitfireHSM by selecting "Iconify" from the 

"Project" menu with the right mouse button, or by pressing Right-Amiga and I. 
This is handy if you're finding that Workbench is becoming cluttered. 

 
 

Accessing the Spitfire² Desktop Application Manager 
 
It is possible for you to start the Spitfire² Desktop Application Manager 
(SpitfireDAM) from within SpitfireHSM. This saves you from loading up 
SpitfireDAM separately. SpitfireHSM enables you to either load up individual 
applications (such as the Address Book) or load up the SpitfireDAM itself (from 
which you can load any of the applications). 
 
To start the SpitfireDAM itself, simply select "Desktop" from the "Tools" menu 
by holding down the right mouse button. Alternatively, you can press Right-
Amiga and D to do the same thing. SpitfireDAM will then load. (See the 
SpitfireDAM chapter for more details about how to use this part of Spitfire²). 

 
To start individual applications (Address Book, Date Book, Memo Pad, To Do 
List and Install) simply select the application from the list in the "Tools" menu 
with the right mouse button. The application will then load. (Once again, see the 
SpitfireDAM chapter for more details). 

 
 

Quitting the SpitfireHSM 
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When you've finished using SpitfireHSM, all you need to do is select "Quit" from 
the "Project" menu, or press Right-Amiga and Q. You can also click on the "Quit" 
button in the SpitfireHSM window. 
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The Spitfire² Desktop Application Manager (SpitfireDAM) is the launch pad for 
starting the various applications within Spitfire². The Address Book, Date Book, 
Memo Pad and To Do List are all accessible, and you can also install additional 
PalmOS software from the SpitfireDAM. 
 

Starting up SpitfireDAM 
 
SpitfireDAM can be started by double-clicking on its icon in the Spitfire² 
directory, or it can be started from within the SpitfireHSM (see the previous 
chapter). Upon loading, a small window will pop up with icons representing each 
available application. To start a particular application, simply click on that 
application's icon. 
 
Each application will now be considered in turn. When you've finished using 
SpitfireDAM, simply select "Quit" from the "Project" menu (Right-Amiga and 
Q). 
 

The Address Book 
 
The first icon in the SpitfireDAM panel is the Address Book icon. The Address 
Book replicates the Address Book function on your Palm device. You can create, 
edit and delete addresses just like on your Palm. With SpitfireHSM (see last 
chapter) you can keep the Address Book in Spitfire² and on your Palm 
synchronized, enabling you to have all your important addresses both on your 
Amiga and wherever you take your Palm. 
 
Upon clicking on the Address Book icon, the Address Book window will appear. 
At the top of the window your username will be visible. (See Advanced Spitfire² 
Operations for details on how to use multiple Palm devices). To the left of the 
window will be the list of available addresses. Clicking on one of these addresses 
will bring up the details for that address in the right-hand part of the window. If 
there are a number of addresses, use the scroll bar to move up and down. 
Alternatively, click on one of the addresses in the list, and then use the up and 
down cursor keys to move between the addresses. The details of each address in 

Chapter 3 

Spitfire Desktop 
Application Manager 
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the right-hand part of the window will change as you move between each one in 
the list. 
 

Creating a new address 
 
To create a new address, simply click on the "New" button in the bottom left-hand 
corner of the window, or press Right-Amiga and N. The "item editor" will pop up, 
from where you can enter the new address. It has all the features you will find in 
your Palm Address Book. You can enter multiple phone numbers (up to five), full 
name and company details, and mailing address. Should you need to add more 
information, there are four custom fields, and by clicking on the "Note" button 
you can add additional information as well. 
 
When you're done, simply click on the "Okay" button at the bottom of the 
window to add the new address to the Address Book, or "Cancel" to reject the 
new address. 
 
Help! Can't find all of the fields? Note that there are two tabs - one labelled "Name" 

and one labelled "Address". Simply click on the recessed tab to bring it to the 
front. Then you'll be able to see all the other fields! 

 
Categorizing addresses 

 
Just like on your Palm, you can categorize your addresses. For example, you can 
have business and personal addresses in separate categories. When you create an 
address, it is simply placed in the "unfiled" category. However if you click on the 
icon to the right of the category box, it will produce a list of available categories. 
(This will usually list at least "Business", "Personal" and "Unfiled"). To change to 
one of these categories, simply double-click on it and the new address will be 
filed under that category. 
 
To add new categories, return to the main Address Book window. Using your 
right mouse button, select "Edit Categories..." from the "Addresses" menu. 
Alternatively, press Right-Amiga and C to do the same thing. This will bring up 
the category list, from which you can add new categories, change the name of 
existing categories or delete categories. To add a new category, click on the 
"New" button and enter the new category name. ("Untitled" will appear - simply 
delete this and insert your new category name). Press Enter when you're finished 
to add the new category. 
 
To change the name of an existing category, click on its name in the category list 
and then make the changes in the bottom text box. To delete a category, simply 
click on the category you wish to delete and then click on the "Delete" button. 
You will be asked whether you wish to delete this category or not. 
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Editing existing addresses 
 
From the main Address Book window, you can edit existing addresses simply by 
clicking on the desired address from the list, and clicking on the "Edit" button at 
the bottom of the window. Alternatively you can select "Edit" from the 
"Addresses" menu, or press Right-Amiga and E. You can then add, change and 
delete information using the same process detailed above when adding a new 
address. 
 
To change the category of a particular address, simply select the category from 
the list by clicking on the button to the right of the category box. If you need to 
add or change categories, see the details above (Categorizing addresses). 
 
To save the changes you have made simply click on the "Okay" button. To reject 
them, click on the "Cancel" button. 
 

Deleting existing addresses 
 
To delete an address, simply click on the address you wish to delete from the list, 
and then click on the "Delete" button. (Or choosing "Delete" from the 
"Addresses" menu, or pressing Right-Amiga and D). You will be asked to 
confirm the deletion. You can also delete multiple addresses simply by holding 
down the left mouse button and dragging the mouse over the addresses you wish 
to delete. Then click on "Delete" and you will be asked to confirm deleting all the 
highlighted addresses. 
 

Copying and pasting address information 
 
As Spitfire² is a MUI application it is possible to copy and paste text from the 
Address Book to other programs or to copy text from other programs to insert in 
an address. For example, you could copy an email address from your web-
browser and then paste it into the email field of a Spitfire² address by pressing 
Right-Amiga and V. Likewise, you can copy information from addresses in the 
Address Book by highlighting the text in the right-hand window of a particular 
address (simply hold down the left mouse button over the text and drag the mouse 
pointer until you have highlighted the text you wish to copy. The text will then be 
placed on the clipboard to be pasted in any Amiga application). 
 
Tip! For exporting and importing addresses from VaporWare's Contact Manager, or 

from other programs that use the CSV format, see the Advanced Spitfire² 
Operations chapter. 

 
Finding an address 

 
[Is this implemented yet?] 
 



Spitfire Desktop Application Manager  

- 15 - 

Customizing the custom fields 
 
In each address it is possible to add information in four "custom" fields. These 
custom field names (labelled Custom 1 to Custom 4) can be renamed from the 
main Address Book window. Simply select "Rename Custom Fields..." from the 
"Addresses" menu, or press Right-Amiga and R. This will bring up a window 
where you can rename these fields. Click "Okay" to make the changes, or 
"Cancel" to reject them. Any changes to these field names will apply across all 
your addresses. 
 

Keeping addresses private 
 
You will notice the "Private" option that can be checked. This enables you to hide 
certain addresses from the view of others by requiring a password to view 
checked addresses on your Palm. See the Advanced Spitfire² Operations chapter 
for more details. 
 

Quitting the Address Book 
 
When you've finished working with the Address Book, simply choose "Quit" 
from the "Project" menu, or press Right-Amiga and Q. Any changes you make 
will be automatically saved. 
 
Tip! Remember, if you want any changes you make in Spitfire²'s Address Book to 

be in your Palm when you need it, make sure to run SpitfireHSM and perform a 
HotSync with your Palm! 

 
 

The Date Book 
 
The second icon in the SpitfireDAM is the Date Book. Clicking on it will bring up 
the Date Book application, which replicates the Date Book on your Palm. This 
allows you to create, edit and view entries for any day of any year. At the top of 
the window will be your username. (Once again, see the Advanced Spitfire² 
Operations chapter for dealing with multiple Palm devices). Below that will 
appear the current date. 
 
Help! Spitfire² has got today's date wrong! This probably means that your Amiga 

doesn't have its system clock set correctly. You can set the right date by 
double-clicking on the "Time" Preferences in the "Prefs" drawer of your 
AmigaOS partition. See your AmigaOS manuals for more details. Remember 
too that your Amiga will need to have a battery backup to remember the correct 
time and date when it is switched off. 

 
Creating a new appointment 
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When the Date Book opens, it will show the current appointments (if any) for the 
current day. If you wish to create an appointment on a different day, you will need 
to change the date. On the right hand side of the window, the dates of the current 
month are shown. To change to a day within the current month, simply click on 
the date. If you need to change the month, you can select it by clicking on the 
month button. Likewise, you can select the year by clicking on the year button 
(which scrolls from left to right). Alternatively, you can change the year by 
clicking on the forward and backward arrows. Below the days of the month, three 
quick access buttons enable you to jump to common dates - today's date, this 
month, and this year. Simply click on them to return to these dates. 
 
When you have selected the right date for the new appointment, simply click on 
the "New" button in the bottom of the Date Book window to create it. (Or press 
Right-Amiga and N, or select "New..." from the "Date Book" menu). This will 
bring a window that allows you to enter information about the new appointment. 
The first option is to set the time of the appointment. Click on the clock button to 
bring up a requester - you can use the scroll bars to set the start and finish times 
for the appointment. If you decide to have no time set, simply click on the "no 
time" button. When you have finished, click on the "Okay" button to set the time 
of the appointment, or "Cancel" to reject your changes. 
 
The next option is to set the date of the new appointment. By clicking on the date 
button, it brings up a requester exactly the same as appears in the right hand side 
of the main Date Book window. If you haven't changed to the right date for your 
new appointment before you started creating the new appointment, this enables 
you to set the date. 
 
The next option deals with the repeat options. Click on the repeat button to bring 
up its requester. There are options to have the appointment repeat daily, weekly, 
monthly by day, monthly by week and yearly. Each option also enables you to set 
an end date where the appointment will stop repeating. This is ideal if, for 
example, you have a weekly meeting that continues until the end of the year. Set 
the appointment on the weekly repeat function, and then click on the date button 
in the repeat window, and select the last week of the year. 
 
The alarm option in next. Click in the box to check it, and you will be able to 
warn yourself of the appointment minutes, hours or days before the appointment. 
Click on the number and you can scroll to the desired value. Then choose from 
minutes, hours or days from the button on the right. 
 
Like the Address Book, it is possible to keep certain appointments private. 
Clicking on the "Private" check box will activate this for this particular 
appointment. See the Advanced Spitfire² Operations for more details. 
 
By clicking on the "Note" button, you can add a note to an appointment. If you 
enter text into the note requester, it will only appear if you click on the note icon 
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for the appointment. For most purposes, it is better to enter the important details 
in the next field (the normal text field) and use the note button for additional 
information. 
 
The final part of the appointment is the text window, where you can enter details 
about the appointment. Simply click in the area and type any text. When you have 
finished with all these details, click on the "Okay" button to set the appointment 
or "Cancel" to reject it. The new appointment will then appear in the "Daily 
Appointments" list on the left hand side of the main Date Book window. 
 
Help! Can't find the new appointment? If you set the date of the appointment in the 

new appointment window, rather than by going to the date in the main Date 
Book window, the appointment won't appear when you've finished. This is 
because you won't be seeing the right day! To find you appointment, simply 
change the date settings to the day you chose for the appointment and it 
should appear! 

 
Tip! Keep on forgetting those birthdays? Create an appointment on the day and 

then set it to the yearly repeat option. Then use the alarm option to warn you to 
buy a present a week in advance! 

 
Editing an appointment 

 
Using the above technique as a guide, find the appointment you wish to change 
and then click on it with the left mouse button. Then click on the "Edit" button in 
the bottom part of the window. (Or chose "Edit..." from the "Date Book" menu, or 
press Right-Amiga and E). The same window will pop up as was used to create 
appointments (see above), but with the current details of the appointment already 
set. To change them, simply click on the appropriate icon, scroll bar or text box. 
When you've finished, click on "Okay" to make the changes, or "Cancel" to reject 
them. 
 

Deleting appointments 
 
To delete an appointment, firstly find the appointment you wish to delete (using 
the above technique as a guide) and click on it. Then click on the "Delete" button, 
choose "Delete..." from the "Date Book" menu or press Right-Amiga and D. 
Spitfire² will ask you to confirm the deletion. You can delete any number of 
appointments in a day simultaneously by highlighting them with the left mouse 
button, and then choosing delete. You will be asked to confirm all the deletions. 
 

Copying and pasting Date Book information 
 
Like the Address Book, you can use standard copy and paste techniques to 
transfer information from the Spitfire² Date Book to other applications and vice 
versa. 
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Quitting the Date Book 
 
When you have finished using the Date Book, simply choose "Quit" from the 
"Project" menu, or press Right-Amiga and Q. Spitfire² will save all your changes, 
but remember that a HotSync with SpitfireHSM is necessary to update your 
Palm's Date Book. 
 

Installing additional PalmOS Programs 
 
The third icon in SpitfireDAM is for the Install application. This allows you to 
install additional PalmOS-compatible applications on your Palm device via your 
Amiga. These usually have the extension "PDB" on the end of the file (for 
example, Calc.pdb). Using the Install application in Spitfire² is particularly handy 
if your Amiga is connected to the Internet. There are thousands of sites worldwide 
that offer PalmOS applications for downloading which can add additional 
functionality to your Palm device.  
 
By clicking on the Install icon, the Install window will appear. It lists all the 
programs that are ready to be installed onto your Palm the next time you perform 
a HotSync with SpitfireHSM. To add a new program to be installed, click on the 
"Add" button (or choose "Add..." from the "Files" menu, or press Right-Amiga 
and A). A file requester will appear, from which you can select the PalmOS 
application that you wish to be installed (look for the "PDB" extension). When 
this is selected, click on OK to have the file placed on the install list. 
 
Tip! Use a search engine to find PalmOS programs. You will find that most of the 

software is compressed with the "zip" program. Accordingly, you will need to 
download an unzip program for your Amiga to unarchive the PDB file. 

 
Spitfire² will list the name of the file to be installed, along its size. To remove the 
program simply select it from the list and click on the "Remove" button (or select 
"Remove..." from the "Install" menu or press Right-Amiga and R). You will be 
asked to confirm the removal of the file. By highlighting multiple files, you can 
remove them all at once using the same process. 
 
Help! What if I install a program on my Palm and I later want to remove it? You can 

remove any installed programs by choosing "Delete..." from the main menus of 
your Palm device. See your Palm documentation for further details. 

 
With multiple Palm devices you can select which device you will install the files 
to by clicking on the user button to the right of the user box. See the Advanced 
Spitfire² Operations chapter for more details. 
 
You can also configure the storage directory from which Spitfire² will look for the 
files. Choose "Install..." from the "Settings" menu, or press Right-Amiga and P. A 
small window will appear, which contains a directory path. Either change this by 
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typing in the desired volume and directory, or click on the file requester button 
and browse through to find the directory you need. 
 
When you have finished click on the "Okay" button to finish configuring the 
storage directory. 
 
To quit from the Install application, click on the "Okay" button in the main 
window, or choose "Quit" from the "Project" menu (Right-Amiga and Q). 
 
 

The Memo Pad 
 
The Memo Pad is the fourth application in the SpitfireDAM, and replicates the 
Memo Pad on your Palm. Click on it to bring up the Memo Pad window. Once 
again your username will appear at the top of the window. (See the Advanced 
Spitfire² Operations chapter for using multiple Palm devices with Spitfire²). On 
the left hand side is the Memo List, while the right hand side shows the contents 
of a particular memo when selected from the list. 
 

Creating a Memo 
 
To create a new memo, click on the "New" button, or select "New..." from the 
"Memos" menu (Right-Amiga and N). A window will pop up. To type the 
contents of the memo, simply click in the text input box and a cursor will appear. 
It is also possible to keep a memo private. Clicking on the "Private" check box 
will activate this for this particular memo. See the Advanced Spitfire² Operations 
for more details. When you've finished creating your new memo, click on "Okay" 
to create the new memo, or "Cancel" to reject the memo. 
 

Categorizing memos 
 
Like the Address Book, it is possible to categorize your memos. When a new 
memo is created, the category box will be in the top part of the window. Click on 
the button to the right of the box to select from the available categories. To create 
new categories, select "Edit Categories..." from the "Memos" menu of the main 
Memo Pad window (or press Right-Amiga and C). Follow the same process as 
with the Address Book. 
 
Tip! The categories in the Address Book and the Memo Pad are not interrelated. If 

you create a new category in one of these applications, it will not appear in the 
other. You can of course create the same categories in both. 

 
In the main Memo Pad window you can list the available memos by category type 
by clicking on the button next to the category box, and selecting the desired 
category. 
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Editing a memo 
 
To edit a memo, select the memo you wish to edit from the list in the main Memo 
Pad window. Then click on the "Edit" button (or "Edit..." from the "Memos" 
menu, or Right-Amiga and E). Once you've made the necessary changes, click on 
"Okay" to accept the changes, "Cancel" to reject them. 
 

Deleting a memo 
 
To delete a memo, select the memo and then click on the "Delete" button (or 
choose "Delete..." from the "Memos" menu, or press Right-Amiga and D). You 
will be asked to confirm the deletion. You can also delete multiple memos by 
highlighting them with the left mouse button. When you choose to delete them 
you will be asked to confirm deleting all the selected memos. 
 

Exporting and importing memos 
 
It is possible to export the contents of a memo from Spitfire² to an ASCII (text) 
file, or import an ASCII file into a new memo. You can export either single or 
multiple memos. To export a single memo, select it from the memo list and then 
choose "Export - Single File..." from the "Memos" menu (or Right-Amiga and S). 
A file requester will appear - simply type the name for the new ASCII file and 
make sure it is in the desired directory. Then click "OK" to save it. For multiple 
memos, highlight the memos from the list and then choose "Export - Multiple 
Files..." from the "Memos" menu (Right-Amiga and X). A file requester will once 
again appear. Type a name for the memos, and then click "OK". For each memo 
there will be a number after the filename. (For example, if you name the file 
"Test" the first memo will be exported as "Test_1", the second as "Test_2", etc.) 
Each memo will thus be saved in a separate ASCII file. 
 
To import ASCII text into a new memo, choose "Import..." from the "Memos" 
menu (or Right-Amiga and R). A file requester will appear, from which you can 
select the file you wish to import. Click on "OK" and Spitfire² will place the text 
into a new memo automatically. To edit the imported memo, simply follow the 
process detailed above in "Editing a memo". 
 
Remember too that as Spitfire² is a MUI application, you can cut, copy and paste 
text to and from memos and other Amiga applications. 
 

The To Do List 
 
The last icon in the SpitfireDAM is the To Do List icon. This replicates the To Do 
List application on your Palm device. Click on it to bring up the To Do List main 
window. At the top of the window you will see your username. (See the 
Advanced Spitfire² Operations chapter for details on how to use multiple Palm 
devices). 
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Creating a new To Do item 

 
To create a new To Do item, click on the "New" button (or choose "New..." from 
the "To Do" menu, or Right-Amiga and N). This will bring up an additional 
window from which you can enter the new To Do item. You can enter the task 
you need to do in the text box. By clicking on the priority button, it is possible to 
choose from five different levels of priority. (One is the highest priority) It is also 
possible to set a due date by clicking on the button to the right of the due date 
box. There is a choice of common dates (Today, Tomorrow, 1 Week Later) or you 
can choose the date using the standard Spitfire² date window. 
 
If you have further details you wish to add to the To Do item, click on the "Note" 
button and a text box will appear for you to add extra text. By clicking on the 
"Private" check-box, the new To Do item will become hidden on your Palm. See 
the Advanced Spitfire² Operations chapter for more details. 
 
When you have finished creating your To Do item, click on "Okay" to accept the 
new To Do item, or "Cancel" to reject it. 
 

Categorizing To Do items 
 
Like the Address Book and Memo Pad, it is possible to categorize the entries in 
the To Do List. In the main To Do List window the category box can be seen in 
the top part of the window. Clicking on the box beside it will list the available 
categories, from which you can select a category to be shown. When creating a To 
Do item, simply select the appropriate category from the category box in the Item 
Editor window. Alternatively, you can use the edit function (see below) to change 
the category of pre-existing To Do items. By selecting "Edit Categories..." from 
the "To Do" menu (Right-Amiga and C) you can add, change or delete the 
categories. Remember that these categories are not related to those in the Address 
Book or Memo Pad. 
 

Editing a To Do item 
 
To edit a To Do item that has already been created, click on the item from the list 
in the main To Do List window and then click on the "Edit" button (or "Edit..." 
from the "To Do" menu, or Right-Amiga and E). Then edit the item following the 
same process as with creating a new To Do item above. Click "Okay" to make the 
changes, "Cancel" to reject. 
 

Deleting a To Do item 
 
To delete a To Do item, click on the item from the list and then click on the 
"Delete" button ("Delete..." from the "To Do" menu or Right-Amiga and D). You 
will be asked to confirm the delete. It is also possible to delete multiple To Do 
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items by highlighting those items you intend to delete and then choosing "delete". 
You will be asked to confirm deleting all the items. 
 

Completing a To Do Item 
 
When you complete a To Do item, you can check it off just like you can with your 
Palm. Simply double-click in the "Completed" column for each item that has been 
completed. A tick will appear to show that the task is done. 
 

Quitting the To Do List 
 
To quit the To Do List, simply select "Quit" from the "Project" menu, or press 
Right-Amiga and Q. Spitfire² will automatically save the changes, but remember 
that a HotSync with SpitfireHSM is necessary to have the changes transferred to 
your Palm. 
 
 

Configuring the MUI Settings 
 
As Spitfire² is a MUI application, both the main SpitfireDAM window, along with 
each application, can be configured with the standard MUI settings program. 
Simply select "MUI..." from the "Settings" menu to bring up the settings window. 
From here you can alter the appearance of the windows, buttons, etc. of 
SpitfireDAM and the individual applications. It is also possible to snapshot each 
window so that it will appear the way you like it each time it starts. Remember to 
click on the "Save" button in the MUI settings to save any changes you make. 
 
Note: A registered version of MUI is necessary in order to save any changes you 

make to the MUI settings. 
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In this chapter we look at some of the more advanced features of Spitfire². This 
includes using Spitfire² with multiple Palm devices, updating the PalmOS, 
exporting and importing records, and using the "private" function to keep records 
confidential. 
 

Multiple Palms and Spitfire² 
 
Due to the unique username that each Palm device has, Spitfire² will recognize a 
different Palm device should you perform a HotSync with SpitfireHSM. You will 
be prompted to enter a username for the new Palm device.  
 
Once you have performed the initial HotSync with the additional Palm, you can 
create, edit and delete records on both Palms simply by selecting the appropriate 
username from the "User" box at the top of each application window. 
 

Exchanging data between Palms 
 
There are a few options that you can make should you wish to copy records or 
information from one of your Palms to another. Firstly, you can copy and paste 
text in an individual field from one Palm to the other. Simply copy the text you 
need, then change the username for that application and paste the text where you 
need it. 
 
Should you wish to exchange larger amounts of data (such as whole records) you 
can use the Export and Import functions of the Address Book and Memo Pad 
applications to achieve this with these applications. With the Address Book, you 
can either choose to export the selected records in a Contact Manager or CSV 
format. (See below for greater details on the Export and Import functions in 
Spitfire²). Choose the CSV format, for example, and save the exported addresses 
to your hard drive. Then change the username in the Address Book window to the 
other Palm, and choose "Import - CSV" from the "Address Book" window. Select 
the file you had just saved, and the records will be added to the other Palm's 
address book. 
 

Chapter 4 

Advanced Operations 
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Note: Spitfire² will not export or import any "Notes" that were made in any of the 
Address Book records. Accordingly, if you copy an address that has a note 
attached, it won't be copied to the other Palm. To copy the note, simply follow 
the copy and paste technique as explained above, and copy the note from the 
record and paste it into the note field of the address on the other Palm. 

 
Likewise with the Memo Pad, you can export the Memos (which are saved as 
individual ASCII text files) and then import them when you have changed 
usernames in the main Memo Pad window. To export the Memos, simply select 
those records you wish to export with the left mouse button. Then choose "Export 
- Multiple Files..." from the "Memo Pad" menu (Right-Amiga and X). A requester 
will appear - type a name for the ASCII files, which will be numbered 
consecutively (e.g. Test_1, Test_2, etc.). Change usernames, and then choose 
"Import..." from the "Memo Pad" window (Right-Amiga and R) to import the 
files. (Unfortunately Spitfire² will only import single files at a time in the Memo 
Pad). 
 

Updating the PalmOS 
 
It is possible for Spitfire² to install some PalmOS upgrades on your Palm device. 
At present, these are only the minor updates - Spitfire² is at present unable to re-
flash the Flash ROM of newer Palms. 
 
[how would a user go about installing a minor PalmOS update?] 
 

Exporting and Importing Spitfire² records 
 
Spitfire² allows you to export and import records in both the Address Book and 
Memo Pad applications. This is extremely useful should you have a need to use 
the information you have in other Amiga applications. 
 

The Address Book 
 
The Address Book allows two ways of exporting and importing records. You can 
import and export in the Contact Manager format, which allows you to exchange 
data with VaporWare Software's Contact Manager. Or you can import and export 
in CSV format, which is a common format in database software. 
 
If you wish to add Contact Manager records to your Spitfire² Address Book (and 
therefore your Palm when you perform your next HotSync), choose "Import - 
CManager..." from the "Address Book" menu (Right-Amiga and 5). This will start 
up Contact Manager. [How do you proceed from here?] 
 
With importing records stored in CSV format, choose "Import - CSV..." from the 
"Address Book" menu (Right-Amiga and 6). A requester will appear asking you 
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to select the file you that will contain the data. Select it and click on "OK". The 
new data will be converted into Spitfire²/Palm-compatible records. 
 
To export to Contact Manager, simply select the records you wish to export from 
the Address Book list (or to select all of the records choose "Select - All" from the 
"Address Book" menu or press Right-Amiga and A). Then select "Export - 
CManager..." from the "Address Book" menu (Right-Amiga and 1). Spitfire² will 
then automatically add the records to the Contact Manager database. 
 
To export in CSV format, select the records the same way you would to export to 
Contact Manager. Then choose "Export - CSV..." from the "Address Book" menu 
(Right-Amiga and 2). A requester will appear - choose the directory where you 
want to save and enter a filename for the new CSV file. Then click on "OK". You 
can then use the data in other Amiga programs by loading up the CSV file into 
that application. 
 

The Memo Pad 
 
Spitfire² allows you to import or export ASCII text files from the Memo Pad 
application. This is handy if you have information you wish exchange between 
your Palm and other Amiga applications. See the SpitfireDAM chapter under the 
Memo Pad section for more information on how to do this. 
 

Keeping Records Private 
 
Palm devices allow you to keep records private, which can be hidden on your 
Palm with or without a password (see the Security chapter of your Palm manual 
for more details on setting passwords and showing and hiding records). Like your 
Palm applications, Spitfire² applications all allow you to mark an individual 
record as private. Simply click on the "Private" check box to make that record 
private. Spitfire² will continue to show that record, but should you select the hide 
records function on your Palm, that record will not be visible on your Palm 
(assuming of course that you have performed a HotSync to update that record on 
your Palm). 
 
 

Recovering Lost Data 
 
A key advantage with using Spitfire² alongside your Palm is that it enables you to 
restore any lost data should your Palm crash or lose its records. To restore all your 
records, simply perform a HotSync with SpitfireHSM, and Spitfire² will copy all 
the records to your Palm. (With Spitfire² set to synchronize the records between 
Spitfire² and your Palm the records will always be copied across to your Palm in 
the event that the Palm has no records). See the SpitfireHSM chapter for details 
on how to perform a HotSync. 



Menus & Keyboard Shortcuts  

- 26 - 

 

 

SpitfireHSM 
 

Menus 
 
Project - About...  Information about the SpitfireHSM. 
Project - About MUI... Information about MUI. 
Project - Iconify Iconifies SpitfireHSM. Double-click icon to 

resume. 
Project - Home Page... Launches web browser to connect to 

Spitfire² home page (Requires 
OpenURL.library). 

Project - Quit Quits SpitfireHSM. 
 
Tools - View Log... View the HotSync log. 
Tools - Desktop... Launch the SpitfireDAM. 
Tools - Address Book Launch the Address Book application. 
Tools - Date Book Launch the Date Book application. 
Tools - Memo Pad Launch the Memo Pad application. 
Tools - To Do List Launch the To Do List application. 
Tools - Install Launch the Install application. 
 
Settings - HSM... Change the SpitfireHSM settings. 
Settings - Conduits... Change the conduit settings. 
Settings - MUI... Change the MUI settings for SpitfireHSM. 
 

Keyboard shortcuts 
 
Right-Amiga + ? Information about the SpitfireHSM. 
Right-Amiga + / Information about MUI. 
Right-Amiga + I Iconifies SpitfireHSM. Double-click icon to 

resume. 
Right-Amiga + H Launches web browser to connect to 

Spitfire² home page (Requires 
OpenURL.library). 

Right-Amiga + Q Quits SpitfireHSM. 

Chapter 5 

Menus & Keyboard 
Shortcuts 
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Right-Amiga + V View the HotSync log. 
Right-Amiga + D Launch the SpitfireDAM. 
 
Right-Amiga + S Change the SpitfireHSM settings. 
Right-Amiga + C Change the conduit settings. 
Right-Amiga + M Change the MUI settings for SpitfireHSM. 
 

SpitfireDAM 
 

Menus 
 
Project - About...  Information about the SpitfireDAM. 
Project - About MUI... Information about MUI. 
Project - Iconify Iconifies SpitfireDAM. Double-click icon to 

resume. 
Project - Quit Quits SpitfireDAM. 
 
Settings - MUI... Change the MUI settings for SpitfireDAM. 
 

Keyboard shortcuts 
 
Right-Amiga + ? Information about the SpitfireDAM. 
Right-Amiga + / Information about MUI. 
Right-Amiga + I Iconifies SpitfireDAM. Double-click icon to 

resume. 
Right-Amiga + Q Quits SpitfireDAM. 
Right-Amiga + M Change the MUI settings for SpitfireDAM. 
 

Address Book 
 

Menus 
 
Project - About...  Information about the Address Book. 
Project - About MUI... Information about MUI. 
Project - Iconify Iconifies the Address Book. Double-click 

icon to resume. 
Project - Quit Quits the Address Book. 
 
Addresses - New Create new address. 
Addresses - Edit Edit an existing address.  
Addresses - Delete Delete selected addresses. 
Addresses - Export - CManager... Export selected addresses to CManager. 
Addresses - Export - CSV... Export selected addresses to CSV-format 

file. 



Menus & Keyboard Shortcuts  

- 28 - 

Addresses - Import - CManager... Import CManager addresses. 
Addresses - Import - CSV... Import addresses in CSV format. 
Addresses - Find... Find text in addresses. 
Addresses - Select - All Select all addresses 
Addresses - Select - None Select none of the addresses. 
Addresses - Edit Categories... Edit categories for filing addresses. 
Addresses - Rename Custom Fields.. Rename custom fields. 
 
Settings - Address Book... [Not implemented] 
Settings - MUI... Changes the MUI settings for the Address 

Book. 
 
 

Keyboard shortcuts 
 
Right-Amiga + ? Information about the Address Book. 
Right-Amiga + / Information about MUI. 
Right-Amiga + I Iconifies the Address Book. Double-click 

icon to resume. 
Right-Amiga + Q Quits the Address Book. 
 
Right-Amiga + N Create new address. 
Right-Amiga + E Edit an existing address.  
Right-Amiga + D Delete selected addresses. 
Right-Amiga + 1 Export selected addresses to CManager. 
Right-Amiga + 2 Export selected addresses to CSV-format 

file. 
Right-Amiga + 5 Import CManager addresses. 
Right-Amiga + 6 Import addresses in CSV format. 
Right-Amiga + F Find text in addresses. 
Right-Amiga + A Select all addresses 
Right-Amiga + O Select none of the addresses. 
Right-Amiga + C Edit categories for filing addresses. 
Right-Amiga + R Rename custom fields. 
 
Right-Amiga + B [Not implemented] 
Right-Amiga + M Change the MUI settings for the Address 

Book. 
 

Date Book 
 

Menus 
 
Project - About...  Information about the Date Book. 
Project - About MUI... Information about MUI. 
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Project - Iconify Iconifies the Date Book. Double-click icon 
to resume. 

Project - Quit Quits the Date Book. 
 
Date Book - New Create a new entry. 
Date Book - Edit Edit an existing entry. 
Date Book - Delete Delete selected entries. 
 
Settings - MUI... Change the MUI settings for the Date Book. 
 

Keyboard shortcuts 
 
Right-Amiga + ? Information about the Date Book. 
Right-Amiga + / Information about MUI. 
Right-Amiga + I Iconifies the Date Book. Double-click icon 

to resume. 
Right-Amiga + Q Quits the Date Book. 
 
Right-Amiga + N Create a new entry. 
Right-Amiga + E Edit an existing entry. 
Right-Amiga + D Delete selected entries. 
 
Right-Amiga + M Change the MUI settings for the Date Book. 
 

Install 
 

Menus 
 
Project - About...  Information about the Install application. 
Project - About MUI... Information about MUI. 
Project - Iconify Iconifies the Install application. Double-

click icon to resume. 
Project - Quit Quits the Install application. 
 
File - Add... Add additional files to be installed to your 

Palm. 
File - Remove... Remove files to be installed to your Palm. 
 
Settings - Install... Change the settings for the Install 

application. 
Settings - MUI... Change the MUI settings for the Install 

application. 
 

Keyboard shortcuts 
 
Right-Amiga + ? Information about the Install application. 
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Right-Amiga + / Information about MUI. 
Right-Amiga + I Iconifies the Install application. Double-

click icon to resume. 
Right-Amiga + Q Quits the Install application. 
 
Right-Amiga + A Add additional files to be installed to your 

Palm. 
Right-Amiga + R Remove files to be installed to your Palm. 
 
Right-Amiga + P Change the settings for the Install 

application. 
Right-Amiga + M Change the MUI settings for the Install 

application. 
 

Memo Pad 
 

Menus 
 
Project - About...  Information about the Memo Pad. 
Project - About MUI... Information about MUI. 
Project - Iconify Iconifies the Memo Pad. Double-click icon 

to resume. 
Project - Quit Quits the Memo Pad. 
 
Memos - New... Create a new memo. 
Memos - Edit... Edit an existing memo. 
Memos - Delete... Delete selected memos. 
Memos - Export - Single File... Export selected memos to one file. 
Memos - Export - Multiple Files... Export selected memos to separate files. 
Memos - Import... Import ASCII text as a memo. 
Memos - Select - All Select all memos. 
Memos - Select - None Select none of the memos. 
Memos - Edit Categories... Edit categories for filing memos. 
 
Settings - Memo Pad... [Not implemented] 
Settings - MUI...  Change the MUI settings for the Memo Pad. 
 

Keyboard shortcuts 
 
Right-Amiga + ? Information about the Memo Pad. 
Right-Amiga + / Information about MUI. 
Right-Amiga + I Iconifies the Memo Pad. Double-click icon 

to resume. 
Right-Amiga + Q Quits the Memo Pad. 
 
Right-Amiga + N Create a new memo. 
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Right-Amiga + E Edit an existing memo. 
Right-Amiga + D Delete selected memos. 
Right-Amiga + S Export selected memos to one file. 
Right-Amiga + X Export selected memos to separate files. 
Right-Amiga + R Import ASCII text as a memo. 
Right-Amiga + A Select all memos. 
Right-Amiga + O Select none of the memos. 
Right-Amiga + C Edit categories for filing memos. 
 
Right-Amiga + P [Not implemented] 
Right-Amiga + M Change the MUI settings for the Memo Pad. 
 

To Do List 
 

Menus 
 
Project - About...  Information about the To Do List. 
Project - About MUI... Information about MUI. 
Project - Iconify Iconifies the To Do List. Double-click icon 

to resume. 
Project - Quit Quits the To Do List. 
 
To Do - New... Creates a new To Do item. 
To Do - Edit... Edits an existing To Do item. 
To Do - Delete... Deletes selected To Do item(s). 
To Do - Select - All Select all the To Do items. 
To Do - Select - None Select none of the To Do items. 
To Do - Edit Categories... Edit categories for filing the To Do items. 
 
Settings - To Do List... [Not implemented] 
Settings - MUI... Change the MUI settings for the Memo Pad. 
 

Keyboard shortcuts 
 
Right-Amiga + ? Information about the To Do List. 
Right-Amiga + / Information about MUI. 
Right-Amiga + I Iconifies the To Do List. Double-click icon 

to resume. 
Right-Amiga + Q Quits the To Do List. 
 
Right-Amiga + N Creates a new To Do item. 
Right-Amiga + E Edits an existing To Do item. 
Right-Amiga + D Deletes selected To Do item(s). 
Right-Amiga + A Select all the To Do items. 
Right-Amiga + O Select none of the To Do items. 
Right-Amiga + C Edit categories for filing the To Do items. 
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Right-Amiga + T [Not implemented] 
Right-Amiga + M Change the MUI settings for the Memo Pad. 

 
 


